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1 Introduction 

RF Cascade Workbook 2003 incorporates many features requested by users over the last year. While 
automated program features and multi-page displays are useful, it seems most users would rather have the 
convenience and ease of all input and output cells being on a single worksheet, and have most of the 
formulas in a VBA1 routine to maintain uncluttered cells and simple manipulation. Another concern is the 
rather large size of the basic workbook, since every system saved creates a file the size of the entire 
workbook. Here is brief list of changes for RF Cascade Workbook 2003: 
 All input/output cells located on a single worksheet (makes inserting/deleting rows simpler) 
 Removed pop-up calculators since they just make the workbook larger 
 Put the vast majority of cell formulas in VBA code for easy manipulation 
 Added the ability to specify individual device IP2 and IP3 as input or output referenced 
 Provided this user’s guide, and eliminated the online help (smaller workbook file size) 
 Put device tolerance and Min/Max cells next to Nominal parameters 
 Modified formulas to reflect gain min/max values in addition to device min/max variations 
 Added a minimum system SNR value for use in calculating dynamic range 
 Employed Excel’s outline feature to easily show/hide Min/Max values 
 Reduced the number of default graphs (smaller workbook file size) 
 Reduced the overall file size to under 200 kBytes 

All of the formulas used in RF Cascade Workbook 2003 are presented in the following paragraphs to assist 
in understanding the operation of the spreadsheet. Most calculations are implemented in VBA code, which 
makes customization more convenient and keeps clutter out of the cells. This is especially helpful in the case 
of conditional formulas. Expansion of the workbook to include custom calculations is a simple matter. Excel 
has a very extensive Help section for VBA code writing. 

1.1 Terms of Use 

You may freely modify RF Cascade Workbook 2003 for your own use; however, you may not redistribute it 
under a new name after making changes. Furthermore, you may not redistribute RF Cascade Workbook 2003 
for any reason without the written permission of RF Café, because this is licensed software, protected under 
U.S. copyright. RF Cascade Workbook 2003 is NOT shareware or freeware. 

Your use of RF Cascade Workbook 2003 attests to your agreement to hold harmless Kirt Blattenberger and 
his assigns for any losses that may occur as a result of the use of RF Cascade Workbook 2003. Every iota of 
code is available for review and discernment by the user, who is consequently solely responsible for all 
results. RF Cascade Workbook 2003 has been tested and is believed to be free of errors upon release. 
Formulas used in RF Cascade Workbook 2003 are not proprietary and have been obtained from multiple 
sources. 

Prior to using this workbook for the first time, please be sure to create a backup copy so the original version 
is always accessible. If you loose track of the original and I have your name on file as a legal licensee, I will 
gladly e-mail a replacement version upon request (I’ve done that sort of thing, too). 

1.2 VBA Code Access 

Access to the VBA code is made using the “Tools→Macro→Visual Basic Editor” menu selection (Figure 1), 
and choosing the relevant page. Note that different versions of Excel might have slightly different menu 
structures, so your menu might look different from Figure 1. 

                                                   
1 Visual Basic for Applications 
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Figure 1   VBA Menu Access 

Figure 2 shows a portion of the VBA code window, where you can make changes to existing functions, or 
add new ones of your own. The “Option Explicit” directive forces the declaration of all variables, which aids 
during the debug process by eliminating the difficult to find misspelled variable or constant that is so easy to 
have in VB. 

 
Figure 2   VBA Code Window 

2 Adding Or Deleting Rows 

Adding or deleting a row (or rows) is a simple process, but care must be taken to be certain that the cascaded 
formula sequences are not lost. Here is a step-by-step method that assures cascade integrity. One simple rule 
applies to adding and deleting rows: 

Never Select the First Two Rows Or the Last Two Rows 

There are other methods of adding or deleting rows, but this one seems to be the most foolproof. 
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2.1 Adding Rows 

 

 

 
-- Use the Ctrl+C keyboard combination to copy the rows to the Windows clipboard. 

 
-- Use the Ctrl+V keyboard combination to paste the rows into the worksheet from the Windows clipboard. 

 

2.2 Deleting Rows 

 

Highlight the rows 
where you want to 

insert the new rows.

Go back and highlight 
the row just above the 

newly inserted rows.

Highlight the newly 
inserted rows PLUS the 

one immediately below it.

Click the cursor on the Insert→Rows menu item.

Resulting new rows that 
maintain continuity of 

cascaded formulas. 
Done!

Highlight the rows 
where you want to 

delete existing rows.
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-- Use the Ctrl+C keyboard combination to copy the rows to the Windows clipboard. 

 
 

 

-- Use the Ctrl+V keyboard combination to paste the rows into the worksheet from the Windows clipboard. 

 

3 System Specification 

System parameter specifications are located in the upper left region of the worksheet as shown in Figure 3. A 
brief explanation of each parameter is given in Table 1. All cell input data is validated for correctness. 

 
Figure 3   System Specification Input Area 

Parameter Description Range Tolerance Units 

P[input] Signal power level at system input -1000 to +1000 - dBm 
Temp System reference temperature – used for noise power 

calculations. (-273.15 is absolute zero) 
-273.14 to +1000 - C 

Min SNR Minimum system SNR used to calculate the dynamic 
range (SDR) 

-100 to +100 - dB 

Click the cursor on the Edit→Delete menu item.

Go back and highlight 
the row just above the 

newly deleted rows.

Highlight the first row  
where the deleted rows 

used to be (this will be the 
first row where the red 

#### characters appear).

Done!
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Parameter Description Range Tolerance Units 

Use VSWR Determines whether the interface VSWR mismatch 
errors are included in the cascaded Gain equation, which 
in turn affects every other equation in the system. 

“y” or “Y” to include 
“n” or “N” to exclude 

- - 

Table 1    System Input Parameters 

4 Device Specification 

Each device is specified similar to what is shown in Table 2. Figure 4 identifies each of the special features 
in the worksheet, so please review it carefully before proceeding. Note that due to the new layout of the 
device parameter input cells, it is not possible to simply copy and paste from a previous version or 
RF Cascade Workbook into this one. It will be necessary to retrieve the tolerance values from the 
“Min-Max 1” worksheet of previous versions. All cell input data is validated for correctness. 

 
Figure 4   Device Specification Input Area 

A description of and allowable input range for each device parameter is given in Table 2. Limits have been 
set using the “Data→Validation” menu selection (Figure 5), and may be changed by the user. Keep in mind 
if you decide to increase the limits on dB values (although it is hard to imagine why the need would arise) 
that the VBA functions use double precision numbers with a maximum value of around 10308, so values like 
NF, IP2 and IP3 that need to be converted from decibels to linear numbers during calculation could exceed 
the limit and cause an error to display in the cells. Cell contents are validated using the built-in Excel data 
validation feature (use … menu for modify). 

 
Figure 5   Data Validation Menu Access 

Parameter Description Range Tolerance Units 

Click here to expose 
tolerance cells 

Click here to hide 
tolerance cells 

Parameter check cell: 
S = Output power will exceed Psat 
N = NF < > |-Gain| 
T = Tolerance >  Nom/2 for  
                           Gain or NF 

Device parameter 
reference:   I = input

O = output
Row 12 contains 

phantom devices that 
precede the 1st actual 

device. It will normally 
be hidden.

Hover cursor here 
to view hints 
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Parameter Description Range Tolerance Units 

Device Designation Descriptive name - - - 
Gain Linear power Gain -1000 to +1000 -1000 to +1000 dB 
NF Noise Figure 0 too +1000 0 to +1000 dB 
I/O Input/Output parameter reference – 

applies only to IP2 and IP3. Conversion of 
the input value is not made automatically 
by switching between “I” and “O,” so 
entering +20 dBm as the IIP3 (with an “I” 
in the “I/O” cell) and then changing to an 
“O” will result in the +20 dBm being 
interpreted as the OIP3. Make the 
conversions as follows: 
OIP2(3) = IIP2(3) + Gain 
IIP2(3) = OIP2(3) - Gain 

“i” or “I” for input 
“o” or “O” for output 

- - 

IP2 2nd-Order Intercept Point -1000 to +1000 -1000 to +1000 dBm 
IP3 3rd-Order Intercept Point -1000 to +1000 -1000 to +1000 dBm 
P[sat] Saturated Power -1000 to +1000 -1000 to +1000 dBm 
Note 
(this is not an input) 

Displays alert for the following 
conditions: 
N = A negative value is entered in the 
       Gain cell, but the NF is not equal 
       to the absolute value of the Gain. 
S = The input power plus linear Gain 
       results in an output power greater 
       than the saturated power for the 
       device. 

T = Tolerance is greater than Gain/2 
       or NF/2 

- - - 

NBW Noise Bandwidth 10-6 to 106 - MHz 
Input Return Loss 

RL = 
1
1

log20 10 


VSWR
VSWR

*  
10-3 to 100 - dB 

Output Return Loss 
RL = 

1
1

log20 10 


VSWR
VSWR

*  
10-3 to 100 - dB 

Table 2    Device Input Parameters 

5 Output (Calculated) Parameters 

Although the definitions of system cascaded parameters are pretty much standard throughout the industry, all 
of the formulas and assumptions used in RF Cascade Workbook 2003 are presented here in order to eliminate 
any ambiguity. Since formulas are contained in VBA code, you may easily modify them to suit your 
individual preferences without having to edit sometimes lengthy formulas in the directly cell. 

One tip when viewing the cell formulas is to initially place the cursor in the cell, then click 
the “fx” icon on the tool bar. This will call up the function dialog box as shown in make 
modification and evaluation of the function output simpler because the result will be 
displayed as parameters are changed. 

This section presents all of the formulas used in the VBA functions to calculate system cascade parameters. 
In the following equations, the subscript “N” refers to the current stage device parameter, while “N-1” refers 
to the cascaded system parameters up through and including the previous stage. Use Figure 6 as a reference 
when interpreting the formulas. For example, GainN refers to the gain of the current stage’s device. GainN-1 
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refers to the cascaded gain of all stages preceding the current stage. So referring to Figure 6, for N=3, 
DeviceGainN = 20 dB, and NomGainN-1 = -5 dB. Finally, upper case names refer to decibel values (e.g., 
20 dB or 20 dBm), while lower case names refer to linear values (e.g., x100 or 100 mW). 

Min/max formulas are constructed using only combinations that can occur based on the available 
combinations of parameters, rather than just those combinations that yield absolutely the largest and smallest 
values. For instance, the maximum IMD3 value uses the cascaded values of MaxP[sig] and MaxIP3 because 
both use MaxGain. 

 
Figure 6   Formula Reference Designations 

 

 
Figure 7   Function (fx) Dialog Box 

Convert between decibels and non-decibels as follows: 

)(log*10)( 10 pdBP  ,                  10
)(

10
dBP

p   

5.1 Interstage VSWR Mismatch Error (dB) 

VSWR mismatch errors are cause by constructive and destructive interference of the voltage standing waves 
at device interfaces due to impedance mismatches. This is NOT the sum of all VSWR errors (see 
VSWR Mismatch column and right end of worksheet for cumulative). It is assumed that there is infinite 
isolation between the device’s input and output ports. This equations deal with voltage, so the “20*log10 (v)” 
decibel form is used. 

Formulas permitted as input 

DeviceGainN

TolGainN

NomGainN MinGainN

NomGainN-1 MinGainN-1

MaxGainN 

MaxGainN-1 
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- Neg - 

 


























20
_

20
_Out

10

2110

10101log20

1log20

1- NN InR-DeviceVSWR-DeviceVSW

N

*-*        

Γ*Γ- * NegError

 
- Pos - 

 


























20

_

20

_Out

10

2110

10101log20

1log20

1- NN

N

InR-DeviceVSWR-DeviceVSW

**        

Γ*Γ * PosError

 

5.2 Gain (dB) 

Gain values expressed in decibels add arithmetically for the linear operating region (potential output 
compression is ignored) If the “Use VSWR” cell is set to “Y,” then the interstage VSWR mismatch values 
are added to the total gain for Min and Max values. Gain is used in all equations except for VSWR. 

- Nom - 

Nominal cascaded gain uses the sum of the nominal gains for each of the stages. 

NNN DeviceGainNomGainNomGain  1  

- Min - 

Minimum cascaded gain uses the sum of the minimum gains for each of the stages. 
 
                                ,"" 

        ,"" 

1

1
 

NNN

NNNN
N TolGainDeviceGainMinGainNUseVSWRfor

NegVSWRTolGainDeviceGainMinGainYUseVSWRfor
MinGain









 

- Max - 

Maximum cascaded gain uses the sum of the maximum gains of each of the stages. 
 
                             ,"" 

    ,"" 

1

1

NNN

NNNN
N TolGainDeviceGainMaxGainNUseVSWRfor

PosVSWRTolGainDeviceGainMaxGainYUseVSWRfor
MaxGain









 

5.3 Noise Figure, NF (dB) 

Noise figure is effectively the reduction of signal-to-noise ratio from the cascade input to the output. Noise 
figure must be calculated using the non-decibel forms of gain and noise figure, and then converted in decibel. 
These equations deal with power, so the “10*log10 (v)” decibel form is used. 

- Nom - 

Nominal cascaded noise figure uses the nominal gains and noise figures of each of the stages. 

)_(log*10 10 NN nfnomNomNF 

 

1
1 _

1_
__







N

N
NN gainnom

nfdevice
nfnomnfnom  
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- Min - 

Minimum cascaded noise figure uses the maximum gains and minimum noise figures of each of the stages. 

)(min_log*10 10 NN nfMinNF 

  
1

1 max
1__

min_min_







N

NN
NN _gain

nftolnfdevice
nfnf  

- Max - 

Maximum cascaded noise figure uses the minimum gains and maximum noise figures of each of the stages. 

)(max_log*10 10 NN nfMaxNF 

  
1

1 min_
1_

max_max_







N

NN
NN gain

tol_nfnfdevice
nfnf  

5.4 2-Tone, 2nd-Order Intercept Point, IP2 (dBm) 

IP2 is the theoretical power at which the 2nd-order intermodulation products would intersect the power of the 
original tones (CW) the when input/output power slopes are plotted. In the linear region of operation, the 
original tones plot on a 1:1 (normalized) slope, while the 2nd-order products plot on a 2:1 (normalized) slope. 
Therefore, the product tones increase at twice the rate of the original tones, and the lines cross at the IP2 
point. 

- Nom - 

Nominal cascaded 2nd-order intercept point. Uses the nominal gains and IP2s of each of the stages. If device 
input values are specified, then a conversion is first made to equivalent output IP2. The final displayed value 
depends on whether the system is specified for input or for output values. 

)2_(log*202 10 NN ipnomNomIP   

2020
2

20
2

10*10

1

10

1
2_

1
1 NNN DeviceGainNomIPDeviceIP

Nipnom 


 NNN NomGainNomIIPNom OIP  22    :Conversion I/O

 

 

- Min - 

Minimum cascaded 2nd-order intercept point. Uses the minimum gains and minimum IP2s of each of the 
stages. If device input values are specified, then a conversion is first made to equivalent output IP2. The final 
displayed value depends on whether the system is specified for input or for output values. 

)2(min_log*202 10 NN ipMinIP 

 
2020

2
20

22

10*10

1

10

1
2min_

1
1 NNNNN TolGainDeviceGainMinIPTolIPDeviceIP

Nip  


 NNN MinGainMinIIPOIP  22Min    :Conversion I/O
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- Max - 

Maximum cascaded 2nd-order intercept point. Uses the maximum gains and maximum IP2s of each of the 
stages. If device input values are specified, then a conversion is first made to equivalent output IP2. The final 
displayed value depends on whether the system is specified for input or for output values. 

)2(max_log*202 10 NN ipMaxIP 

 
2020

2
20

22

10*10

1

10

1
2max_

1
1 NNNNN TolGainDeviceGainMaxIPTolIPDeviceIP

Nip  


 
NNN MaxGainMaxIIPOIP  22Max    :Conversion I/O  

 

5.5 2-Tone, 3rd-Order Intercept Point, IP3 (dBm) 

IP3 is the theoretical power at which the 3rd-order intermodulation products would intersect the power of the 
original tones (CW) the when input/output power slopes are plotted. In the linear region of operation, the 
original tones plot on a 1:1 (normalized) slope, while the 3rd-order products plot on a 3:1 (normalized) slope. 
Therefore, the product tones increase at three times the rate of the original tones, and the lines cross at the 
IP3 point. 

- Nom - 

Nominal cascaded 3rd-order intercept point. Uses the nominal gains and IP3s of each of the stages. If device 
input values are specified, then a conversion is first made to equivalent output IP3. The final displayed value 
depends on whether the system is specified for input or for output values. 

)3_(log*103 10 NN ipnomNomIP 

 
1010

3
10

3

10*10

1

10

1
3_

1
1 NNN DeviceGainIPDeviceIP

Nipnom 


 
NNN NomGainNomIIPOIP  33 Nom    :Conversion I/O  

- Min - 

Minimum cascaded 3rd-order intercept point. Uses the minimum gains and minimum IP3s of each of the 
stages. If device input values are specified, then a conversion is first made to equivalent output IP3. The final 
displayed value depends on whether the system is specified for input or for output values. 

)3(min_log*103 10 NN ipMinIP 

 
1010

3
10

33

10*10

1

10

1
3min_

1
1 NNNNN TolGainDeviceGainMinIPTolIPDeviceIP

Nip  


 
NNN MinGainMinIIPOIP  33Min    :Conversion I/O  
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- Max - 

Maximum cascaded 3rd-order intercept point. Uses the maximum gains and maximum IP3s of each of the 
stages. If device input values are specified, then a conversion is first made to equivalent output IP3. The final 
displayed value depends on whether the system is specified for input or for output values. 

)3(max_log*103 10 NN ipMaxIP 

 1010
3

10
33

10*10

1

10

1
3max_

1
1 NNNNN TolGainDeviceGainMaxIPTolIPDeviceIP

Nip  


 NNN MaxGainMaxIIPOIP  33Max    :Conversion I/O  

5.6 Saturated Power, P[sat] (dBm) 

P[sat] is the output power at which no further increase in the input power will result in an increase at the 
output. This is an extremely nonlinear region of operation and can only be modeled by sophisticated transfer 
functions that are unique to each device. Therefore, no attempt is made to model it here. Instead, the P[sat] 
value is used as a monitor for the power level in the system to alert the user to a potential problem. A check 
is made to determine whether the power level at the device input, plus the linear gain of the device, results in 
a power level equal to or greater than the P[sat] of the device. If so, then the output power is limited to the 
device’s P[sat] power level. No tolerance input parameter is provided for P[sat] because it normally is not an 
intentional design parameter. 

- Nom - 

Nominal gain and P[sat] values are used per the following equation. 

NNN

NNN

NN

N
N satDevicePDeviceGainsatPif

satDevicePDeviceGainsatPif
DeviceGainsatP

satDeviceP
satNomP

][][ ,
][][ ,

   
][

][
][

1

1

1 











 

- Min - 

Same as Nominal, except the MinGain value is used since it results in a lower power through the cascade. 

NNNN

NNNN

NNN

N
N satDevicePTolGainDeviceGainsatPif

satDevicePTolGainDeviceGainsatPif
TolGainDeviceGainsatMinP

satDeviceP
satMinP

][][ ,
][][ ,

   
][

][
][

1

1

1 











 

- Max - 

Same as Nominal except the MaxGain value is used since it results in a higher power through the cascade. 

NNNN

NNNN

NNN

N
N satDevicePTolGainDeviceGainsatPif

satDevicePTolGainDeviceGainsatPif
TolGainDeviceGainsatMaxP

satDeviceP
satMaxP

][][ ,
][][ ,

   
][

][
][

1

1

1 











 

5.7 Signal Power, P[sig] (dBm) 

P[sig] is the power of the signal as it propagates through the cascade, and is increased or decreased by the 
linear gain of each stage. Note that it is possible for the calculated value to exceed the P[sat] value, because 
no adjustment is made. This is done to prevent the annoying case where all of the other power dependant 
values are thrown off by an adjusted output power value. There is an indication of a saturated condition given 
in the alert column labeled “Note.” 

- Nom - 

NNN DeviceGainsigPsigNomP  1][][  



 Page 13Copyright 2003 Kirt Blattenberger, RF Café Website.  This manual may not be reproduced in part or in whole without the express, written 
permission of Kirt Blattenberger or his assigns. Only licensed users of RF Cascade Workbook 2003 may possess this manual. 

- Min - 

NNNN TolGainDeviceGainsigPsigMinP  1][][  

- Max - 

NNNN TolGainDeviceGainsigPsigMaxP  1][][  

5.8 Noise Bandwidth, NBW (MHz) 

Cascaded noise bandwidth merely checks the NBW of the current device, and sets the system NBW to the 
lesser of either the device NBW or the system’s previous NBW. Only a nominal value is calculated. 

NN

NN

N

N
N NBWNif

NBWNif
NBW

DeviceNBW
NBW





BWDevice ,
BWDevice ,

    

5.9 Noise Power, P[n] (dBm) 

P[n] is the power of the noise as it propagates through the cascade, and is increased or decreased by the gain 
noise figure and NBW of each stage. Since the system temperature is given in Celsius degrees, 273.15 is 
added to get equivalent Kelvin degrees. NWB is given in MHz, so a multiplication by 106 is done. Note that 
MaxGain corresponds to MinNF in the cascaded results, and vice versa. 

- Nom - 

  NNNN NFGainNBWeratureSystemTempnP  6
10 10**15.273log*10][  

- Min - 

  NNNN MaxNFMinGainNBWeratureSystemTempnMinP  6
10 10**15.273log*10][  

- Max - 

  NNNN MinNFMaxGainNBWeratureSystemTempnMaxP  6
10 10**15.273log*10][  

5.10 Signal to Noise Ratio, SNR (dB) 

SNR is the difference between the noise power level and the signal power level. 

- Nom - 

NNN nNomPsigNomPNomSNR ][][   

- Min - 

NNN nMaxPsigMinPMinSNR ][][   

- Max - 

NNN nMinPsigMaxPMaxSNR ][][   

5.11 Saturated Dynamic Range, SDR (dB) 

SDR is the difference between the saturated power level and the noise power level, minus the minimum 
system SNR. This is different than the standard dynamic range (DR), which references the 1 dB compression 
point (P1dB), since RF Cascade Workbook 2003 does not calculate P1dB. 
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- Nom - 

NRMinSystemSnNomPsatNomPNomSDR NNN  ][][  

- Min - 

NRMinSystemSnMaxPsatMinPMinSDR NNN  ][][  

- Max - 

NRMinSystemSnMinPsatMaxPMaxSDR NNN  ][][  

5.12 Spurious-Free Dynamic Range, SFDR (dB) 

SFDR is the theoretical power of two tones at the system input that would generate 3rd-order products at the 
output with a power just equal to the noise power at the output. 

- Nom - 

 NNN nNomPNomIPNomSFDR ][3*
3
2

  

- Min - 

 NNN nMaxPMinIPMinSFDR ][3*
3
2

  

- Max - 

 NNN nMinPMaxIPMaxSFDR ][3*
3
2

  

5.13 3rd -Order Intermodulation Product Power, IMD3 (dBm) 

IMD3 intermod products are caused by the nonlinear mixing of two input tones of equal amplitude. It is 
essentially the same process as in a mixer for frequency conversion, where an infinite series is produced that 
consists every possible frequency according to j*Tone1 k*Tone2. The 3rd -order products that most likely 
fall inband at the output are 2*Tone1 Tone2 and Tone1 2*Tone2. In reality, the powers of most 
products are below the noise power. A smaller (minimum) IMD3 is better. 

- Nom - 

 NNNN sigNomPNomIPsigNomPNomIMD ][3*2][3   

- Min - 

 NNNN sigMaxPMaxIPsigMaxPMinIMD ][3*2][3   

- Max - 

 NNNN sigMinPMinIPsigMinPMaxIMD ][3*2][3   

5.14 Delta 3rd -Order Intermodulation Products, IMD3 (dB) 

Delta IMD3 intermod is the difference between the IMD3 product power, IMD3, and the signal power, 
P[sig]. 

- Nom - 

3][3 NomIMDsigNomPIMDNom NN   
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- Min - 

3][3 MaxIMDsigMinPIMDMin NN   

- Max - 

3][3 MinIMDsigMaxPIMDMax NN   

6 Graphs 

Two worksheets with graphs are provided by default. You may, of course, add as many graphs as necessary 
to plot parameters. Each graph adds about 10 kBytes to the file size. A lot of online help is available through 
Excel for working with graphs. Most parameters can be modified by double-clicking on the item you want to 
change. When a graph is selected, the “Chart” menu item appears on the main menu bar (see Figure 9). From 
there, you can access all of the graph setup parameters. 

If you want to add another graph worksheet, the simplest way is to right-click on the bottom worksheet tab 
and select the “Move or copy…” menu item, and instruct Excel to make a copy per Figure 8 

                   
Figure 8   Copying A Graph Worksheet 
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Figure 9   Graph 

7 Conversion Formulas 

These formulas were implemented in previous version of RF Cascade Workbook as popup windows, but are 
instead supplied here. This reduces the size of every new workbook. 

7.1 Noise Temperature – to – Noise Figure 
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7.2 VSWR – to – Return Loss 
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